## Notations Used in This Guide

The following table shows the symbols used in this manual, along with descriptions of what they mean.

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Caution</strong></td>
<td>Indicates procedures which may result in damage or injury if sufficient care is not taken.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates additional information and points which may be useful to know regarding a topic.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates a page where detailed information regarding a topic can be found.</td>
</tr>
<tr>
<td><strong>Procedure</strong></td>
<td>Indicates operating methods and the order of operations. The procedure indicated should be carried out in the order of the numbered steps.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates the name of the buttons on the projector's remote control or the control panel. Example: Esc button</td>
</tr>
<tr>
<td><strong>Timer</strong> (Boldface)</td>
<td>Indicates the name of the buttons on the EasyMP Monitor or OS screens. Example: Select &quot;Timer&quot; - &quot;Timer Settings&quot;. Select Timer - Timer Settings.</td>
</tr>
</tbody>
</table>
## Contents

**Notations Used in This Guide**

**EasyMP Monitor Features**

**Tasks that can be done using EasyMP Monitor**

**Installing EasyMP Monitor**

**Operating environment**

**Supported language**

**Transferring the settings.**

**Limitations imposed by a Windows Vista or Windows 7 environment**

**Before starting operations**

**Using EasyMP Monitor**

**Registering and deleting projectors for monitoring**

**Registering projectors using automatic search (Searching for and registering projectors that are located in the same segment)**

**Procedures for automatic search**

**Procedures for registration**

**Setting the range of addresses to do an automatic search and registration**

**Procedures for automatic search**

**Procedures for registration**

**Registration by specifying an IP address (Manual registration)**

**Registering several projectors to a monitoring group all at once**

**If the projector name or IP address changes after registration**

**Starting EasyMP Monitor**

**Displaying and deleting logs.**

**Displaying Log.**

**Deleting Log.**

**Displaying Group properties**

**Displaying Projector properties**

**Displaying and deleting logs.**

**Procedures for new timer settings**

**Carrying out control using control buttons.**

**Carrying out control using a web browser (Web control).**

**Carrying out control using timer settings.**

**Procedures for new timer settings**

**Monitoring window layout**

**Types of monitoring windows and switching method**

**How to switch views**

**Monitoring using Grouping view**

**Meanings of Grouping view icons**

**Using the icons in Grouping view.**

**Monitoring using Detail list view**

**Meanings of Detail list view icons**

**Selecting display items.**

**Sorting lists**

**Searching for desired icons (Projector list).**

**Monitoring using the system tray**

**Displaying projectors with problem or warning statuses in a list**

**Checking properties in detail**

**Displaying Group properties**

**Displaying Projector properties**

**Displaying and deleting logs.**

**Making Mail notification function settings.**

**Using the control functions.**

**Carrying out control using control buttons.**

**Carrying out control using a web browser (Web control).**

**Carrying out control using timer settings.**

**Procedures for new timer settings**

**Mail notification function settings**

**E-mail notification**

---

For projectors that have been registered manually: 20
For projectors that have been registered using automatic search: 20
Cancelling projector registrations (Delete): 20

**Monitoring window layout**: 21
Types of monitoring windows and switching method: 21
How to switch views: 21
Monitoring using Grouping view: 22
Meanings of Grouping view icons: 22
Using the icons in Grouping view: 23
Monitoring using Detail list view: 24
Meanings of Detail list view icons: 24
Selecting display items: 26
Sorting lists: 27
Searching for desired icons (Projector list): 27
Monitoring using the system tray: 27
Displaying projectors with problem or warning statuses in a list: 28
Checking properties in detail: 31
Displaying Group properties: 31
Displaying Projector properties: 32
Displaying and deleting logs: 32
Displaying Log: 33
Deleting Log: 33

**Using the control functions**: 34
Carrying out control using control buttons: 34
Carrying out control using a web browser (Web control): 36
Carrying out control using timer settings: 36
Procedures for new timer settings: 37

**Mail notification function settings**: 38

**E-mail notification**: 40
Application lock function ............................................. 43
  Switching Application lock between enabled and disabled .......... 43
    Enabling the application lock ...................................... 43
    Disabling the application lock .................................... 43
  Setting a password for cancelling application lock ................. 43

Appendix

Troubleshooting ......................................................... 45
  Projectors cannot be monitored or controlled ...................... 45
  An e-mail message is not sent when a problem occurs with a projector .. 45

Uninstalling EasyMP Monitor ......................................... 46

Notices ................................................................. 47
  Copyright Notice .................................................... 47
  Trademarks .......................................................... 47
EasyMP Monitor Features
Tasks that can be done using EasyMP Monitor

EasyMP Monitor lets you carry out operations such as checking the statuses of multiple EPSON projectors that are connected to a network at a computer monitor, and controlling the projectors from the computer.

Following are brief descriptions of the monitoring and control functions that can be carried out using EasyMP Monitor.

• **Registering projectors for monitoring and control**
  Projectors on the network can be searched for automatically, and you can then select projectors to be registered from the projectors that are detected.
  You can enter the IP addresses for target projectors to register them.

• **Registered projectors can also be assigned to groups so that they can be monitored and controlled in groups.**

• **Monitoring the statuses of registered projectors**
  The power status (ON/OFF) for projectors and problems or warnings requiring attention can be checked visually by means of icons.
  You can select groups of projectors or a single projector that you are interested in, and then check the cumulative lamp operating time or the details of information such as input sources, problems, and warnings for these projectors.

• **Controlling registered projectors**
  Projectors can be selected in groups or as single projectors, and you can then carry out operations for the selected projectors such as turning the power on and off and switching their input sources.
  Web control functions can be used to change the settings in the projector’s configuration menu.
  If there are certain control actions which are carried out regularly at particular times or on particular days, you can use Timer Settings to register timer settings.

• **Mail notification function settings**
  You can set e-mail addresses to which notifications are sent if a status requiring attention, such as a problem, occurs with a projector that has been registered.

To enable projectors to be monitored and controlled even when they are in standby mode*, make the following settings at the projectors. The settings that need to be made will vary depending on the projector you are using.

**Projector’s User’s Guide**

• Set Standby Mode to Communication On (or Network On).
• Set Network Monitoring to On.

* When the projector’s indicator is lit orange.
Installing EasyMP Monitor

Operating environment

This software is compatible with computers that comply with the following requirements.

- Macintosh computers cannot be used.
- Operations carried out at the computer may become slow depending on the number of projectors being managed. If this happens, use a computer with higher specifications.
- EasyMP Monitor cannot be used in environments which do not allow pings to be transmitted.

Supported language

EasyMP Monitor supports the following languages.

- Japanese, English, Français, Deutsch, Italiano, Español, Català, Português, 한국어, 中文(简体), 中文(繁体), Nederlands, Dansk, Polski, Magyar, Česky, Română, Slovenščina, Norsk, Svenska, Suomi, Русский, Українська*1, Ελληνικά, Türkçe*2, العربية, Bahasa Indonesia, Hrvatski, Slovenčina, Български език, भारतीय मलयालम, tiếng Việt, סידןית*2

*1 If your OS is Windows Vista, you must update to Windows Vista SP1 to use the Ukrainian version of EasyMP Monitor.
*2 Windows NT4.0 does not support Arabic and Hebrew versions.

Transferring the settings

If you are already using EasyMP or EMP Monitor, you can transfer the projector settings to this version. The settings are stored as a data file (EMP Monitor.dat). Make a copy of the EMP Monitor.dat before you install this software. EMP Monitor.dat can be found at the following location if the default settings were used to install the software:

| OS | Windows 98 Second Edition SP1  
|   | Windows Me  
|   | Windows NT4.0 SP6  
|   | Windows 2000 Professional SP4  
|   | The following 32-bit operating systems:  
|   | Windows XP Home Edition SP2/SP3  
|   | Windows XP Professional SP2/SP3  
|   | Windows Vista  
|   | (All editions except Starter Edition)  
|   | Windows Vista SP1/SP2  
|   | (All editions except Starter Edition)  
|   | Windows 7  
|   | (All editions except Starter Edition)  
|   | Internet Explorer Ver. 5.0 or later must be installed.

| CPU | Pentium MMX 166 MHz or higher (Pentium II 233 MHz or higher recommended)  
| Memory capacity | 64 MB or more (128 MB or more recommended)  
| Free hard disk space | 50 MB or more  
| Display | SVGA (800 x 600) or higher resolution, 32 bit or higher display color  

For more information, please visit the official website.
Installing EasyMP Monitor

- If your operating system is Windows 98, Windows Me, Windows 2000, Windows NT4.0, or Windows XP
  "C:\Program Files\EPSON Projector\EasyMP (or EMP) Monitor Ver. x.xx (Ver. x.xx represents the software version)"
- If your operating system is Windows Vista or Windows 7
  "C:\Users\(User Name)\AppData\Local\VirtualStore\Program Files\EPSON Projector\EasyMP (or EMP) Monitor Ver. x.xx (Ver. x.xx represents the software version)"
  If you cannot find the "AppData" folder, click "Start" - "Control Panel" - "Appearance and Personalization" - "Folder Options". Select "View" tab, and then configure the "Show hidden files, folders, and drives" setting in "Advanced settings".

After installing this software, follow the instructions below before starting EasyMP Monitor to transfer the settings.

- If your operating system is Windows 98, Windows Me, Windows 2000, Windows NT4.0, or Windows XP
  Overwrite the existing EMP Monitor.dat file with the copy you made.
The existing EMP Monitor.dat file is in "C:\Program Files\EPSON Projector\EasyMP Monitor Ver.4.40".
- If your operating system is Windows Vista or Windows 7
  Place the copy of the EMP Monitor.dat file in "C:\Users\(User Name)\AppData\Local\VirtualStore\Program Files\EPSON Projector\EasyMP Monitor Ver.4.40".

The software name has been changed.
  Before: EMP Monitor  →  After: EasyMP Monitor
  If you are already using EMP Monitor, you can replace it with this software.

Installing

When you are using the following OS, you must have administrator authority in order to install EasyMP Monitor.

- Windows 2000
- Windows NT4.0
- Windows XP
- Windows Vista
- Windows 7

If EasyMP or EMP Monitor is already installed, uninstall it before installing this software. □ p.46

When your OS language is supported by EasyMP Monitor, the software is installed in the same language as your OS automatically.
However, the following cases are exceptions.

- When using Windows NT4.0: Since Arabic and Hebrew are not supported, English is selected for the installation.
- When using Windows Vista: You must update to Windows Vista SP1 to use the Ukrainian version.
When the language selected for the EasyMP Monitor installation varies from that of the OS being used, the screens may not be displayed correctly.

Procedure

1. Turn the computer on.
   To prevent problems from occurring during the installation, we recommend that you terminate all resident applications that can be ended.

2. Load the supplied Projector Software CD-ROM in your computer.
   The installer automatically starts up.
Installing EasyMP Monitor

From here, continue with the installation by following the on-screen messages.

Limitations imposed by a Windows Vista or Windows 7 environment

When using EasyMP Monitor under Windows Vista or Windows 7, note the following limitations.

- You must have administrator authority in order to use Register at startup on the Environment setup screen of EasyMP Monitor. p.27
- If EasyMP Monitor is installed on your computer, uninstall it before you update the operating system to Windows Vista or Windows 7. Updating your OS without uninstalling the software may cause a malfunction. p.46

Before starting operations

Check the following points before starting up EasyMP Monitor.

- EasyMP Monitor must be installed on the computer to be used for monitoring and control.
- The computer and the projectors must be connected to the network.
- If using Windows 2000/Windows NT4.0/Windows XP/Windows Vista/Windows 7, the computer must be started up in Administrator mode.
- Depending on the projector model, a commercially-available serial TCP/IP conversion adapter and a connection cable are required in order to use EasyMP Monitor. Projector’s User’s Guide

Make the settings for the serial TCP/IP conversion adapter before connecting to the projector.
Using EasyMP Monitor
Registering and deleting projectors for monitoring

This operation is carried out when starting EasyMP Monitor for the first time after it has been installed and when you would like to add projectors. Once a projector has been registered, the status for the projector will be displayed automatically each time EasyMP Monitor is started from that point onwards.

The operations to register projectors vary as followings depending on where the projectors are connected to in the network.

- When registering a projector that is located in the same segment as the computer in which EasyMP Monitor is installed. "Registering projectors using automatic search (Searching for and registering projectors that are located in the same segment)" p.12
- When registering projectors that are in multiple segments of the network. "Setting the range of addresses to do an automatic search and registration" p.14

Starting EasyMP Monitor

Procedure

1. Click "Start" - "Programs" (or "All Programs") - "EPSON Projector" - "EasyMP Monitor Ver.4.40" in that order to start EasyMP Monitor.

2. The main window will be displayed.
The red box area described in the screen below is referred to as Grouping view.
Registering and deleting projectors for monitoring

Registering projectors using automatic search
(Searching for and registering projectors that are located in the same segment)

Procedures for automatic search

Procedure

1. Right-click in Grouping view and select "New" - "Projector (automatic search)".
   The following Create new projector (automatic registration) window will be displayed.
   If Detail list view is displayed, select New - Projector (automatic search) from the Edit menu.

2. Click "Search".
   Automatic searching will be carried out, and the names of the projectors that have been detected will be displayed.
   If a projector does not appear in the list, use "Registration by specifying an IP address (Manual registration)". p.17

• You can also carry out this operation by selecting New - Projector (automatic search) from the Edit menu.
• Projectors that are using a serial TCP/IP conversion adapter cannot be detected.
Registering and deleting projectors for monitoring

Procedures for registration

Procedure

1. Select the projector(s) to be registered from the displayed list, and then click "Edit".

The following window will be displayed.

![Projector registration window]

Make the necessary settings while referring to the following table.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Enter the name of the projector(s) to be displayed in Grouping view or Detail list view. Up to a maximum of 32 bytes can be entered. A space cannot be used as the first character.</td>
</tr>
<tr>
<td>Display icon</td>
<td>Select the icon(s) to be displayed in Grouping view or Detail list view.</td>
</tr>
<tr>
<td>Parent group</td>
<td>Select when registering a projector in a group. If no groups have been created, this cannot be selected. Refer to &quot;Registering several projectors to a monitoring group all at once&quot; on page 18.</td>
</tr>
<tr>
<td>Projector name</td>
<td>This shows the name that has been registered on the projector.</td>
</tr>
<tr>
<td>IP address</td>
<td>This shows the IP address for the registered projector.</td>
</tr>
<tr>
<td>Use Serial ↔ TCP/IP conversion adaptor.</td>
<td>This cannot be selected when registering projectors using automatic search.</td>
</tr>
<tr>
<td>Port Number</td>
<td>This cannot be selected when registering projectors using automatic search.</td>
</tr>
<tr>
<td>Monitor Password</td>
<td>If a Monitor Password has been set for the projector, be sure to enter the Monitor Password that has been set. If the correct password is not entered at this time, it will not be possible to monitor and control the projector even though it is registered.</td>
</tr>
<tr>
<td>Description</td>
<td>You can enter some kind of memo about the projector. The details you enter here will be displayed at the projector properties. Up to a maximum of 60 bytes can be entered.</td>
</tr>
<tr>
<td>Monitor</td>
<td>Select this when you want monitoring to start.</td>
</tr>
</tbody>
</table>
Registering and deleting projectors for monitoring

2 After entering the details, click "Register" to start the registration. When the message is displayed, click "OK". To continue registering other projector(s), repeat Steps 1 and 2.

Projectors that have been registered using automatic search are searched for again by projector name each time EasyMP Monitor is started.

3 To end the registration operation, click in the top-right corner of the window or click "Cancel". The icon(s) of the projector(s) you registered will be displayed in Grouping view or Detail list view.

Refer to "Monitoring window layout" p.21 for details on using the Grouping view and Detail list view.

Setting the range of addresses to do an automatic search and registration

Projectors that are using a serial TCP/IP conversion adapter cannot be detected.

Procedures for automatic search

Procedure

1 Right-click in Grouping view and select "New" - "Projector (automatic search)".

The Create new projector (automatic registration) window will be displayed.

If Detail list view is displayed, select New - Projector (automatic search) from the Edit menu.

2 Select the "Specify an address range and search." check box and then enter "Start address" and "End address" in the range.
3. **Click "Search".**

Automatic searching will be carried out, and the names of the projectors that have been detected will be displayed.

<table>
<thead>
<tr>
<th>Projector name</th>
<th>IP address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projector1</td>
<td>192.160.0.40</td>
</tr>
<tr>
<td>Projector2</td>
<td>192.160.0.41</td>
</tr>
<tr>
<td>Projector3</td>
<td>192.160.0.42</td>
</tr>
<tr>
<td>Projector4</td>
<td>192.160.0.43</td>
</tr>
<tr>
<td>Projector5</td>
<td>192.160.0.44</td>
</tr>
<tr>
<td>Projector6</td>
<td>192.160.0.45</td>
</tr>
<tr>
<td>Projector7</td>
<td>192.160.0.46</td>
</tr>
</tbody>
</table>
Registering and deleting projectors for monitoring

Procedures for registration

Procedure

1. Select the projector(s) to be registered from the displayed list, and then click "Edit".

The following window will be displayed.

<table>
<thead>
<tr>
<th>Display name</th>
<th>Enter the name of the projector(s) to be displayed in Grouping view or Detail list view. Up to a maximum of 32 bytes can be entered. A space cannot be used as the first character.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display icon</td>
<td>Select the icon(s) to be displayed in Grouping view or Detail list view.</td>
</tr>
<tr>
<td>Parent group</td>
<td>Select when registering a projector in a group. If no groups have been created, this cannot be selected. Refer to “Registering several projectors to a monitoring group all at once” p.18</td>
</tr>
<tr>
<td>Projector name</td>
<td>This shows the name that has been registered on the projector.</td>
</tr>
<tr>
<td>IP address</td>
<td>This shows the IP address for the registered projector.</td>
</tr>
<tr>
<td>Use Serial ↔ TCP/IP conversion adaptor</td>
<td>This cannot be selected when registering projectors using automatic search.</td>
</tr>
<tr>
<td>Port Number</td>
<td>This cannot be selected when registering projectors using automatic search.</td>
</tr>
<tr>
<td>Monitor Password</td>
<td>If a Monitor Password has been set for the projector, be sure to enter the Monitor Password that has been set. If the correct password is not entered at this time, it will not be possible to monitor and control the projector even though it is registered.</td>
</tr>
<tr>
<td>Description</td>
<td>You can enter some kind of memo about the projector. The details you enter here will be displayed at the projector properties. Up to a maximum of 60 bytes can be entered.</td>
</tr>
<tr>
<td>Monitor</td>
<td>Select this when you want monitoring to start.</td>
</tr>
</tbody>
</table>

Make the necessary settings while referring to the following table.
After entering the details, click "Register" to start the registration. When the message is displayed, click "OK". To continue registering other projector(s), repeat Steps 1 and 2.

To end the registration operation, click \( \times \) in the top-right corner of the window or click "Cancel".

Refer to "Monitoring window layout" p.21 for details on using the Grouping view and Detail list view.

Registration by specifying an IP address (Manual registration)

Procedure

1. Right-click in Grouping view and select "New" - "Projector (manual registration)".

The following window will be displayed.

If Detail list view is displayed, select New - Projector (manual registration) from the Edit menu.
You can also carry out this operation by selecting `New - Projector (manual registration)` from the Edit menu.

2. Enter the IP address of the projector to be registered in the "IP address" box and then click "Search". When the message is displayed, click "OK".

   If using a serial ↔ TCP/IP conversion adapter and cable to connect the projector, select `Use Serial ↔ TCP/IP conversion adaptor`, enter the port number in `Port Number`, and then click `Search`.

3. After searching is complete, enter the information for the projector to be registered while referring to the table below.

<table>
<thead>
<tr>
<th>Display name</th>
<th>Enter the name of the projector(s) to be displayed in Grouping view or Detail list view. Up to a maximum of 32 bytes can be entered. A space cannot be used as the first character.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display icon</td>
<td>Select the icon(s) to be displayed in Grouping view or Detail list view.</td>
</tr>
<tr>
<td>Parent group</td>
<td>Select when registering a projector in a group. If no groups have been created, this cannot be selected.</td>
</tr>
<tr>
<td>Projector name</td>
<td>This shows the name that has been registered on the projector.</td>
</tr>
<tr>
<td>IP address</td>
<td>This shows the IP address that you entered in step 2.</td>
</tr>
<tr>
<td>Use Serial ↔ TCP/IP conversion adaptor</td>
<td>Select this if using a serial ↔ TCP/IP conversion adapter to connect the projector.</td>
</tr>
</tbody>
</table>

4. After entering the details, click "Register" to start the registration. When the message is displayed, click "OK".

   The icon(s) of the projector(s) you registered will be displayed in Grouping view or Detail list view.

### Registering several projectors to a monitoring group all at once

Projectors that have been registered can then be registered together into different groups so that they can be monitored and controlled together.

Furthermore, if you select one of the registered groups as the Parent group, monitoring and control operations can be carried out for all projectors in that Parent group.

A Parent group can be set for other parent groups, so that a hierarchical group arrangement can be created.
Registering and deleting projectors for monitoring

First, create the registration groups, and then register projectors into the groups that have been created.

**Procedure**

1. **Right-click in Grouping view and select "New" - "Group".**
   The following window will be displayed.
   Make the necessary settings while referring to the table below.
   If Detail list view is displayed, select New - Group from the Edit menu.

   ![](image)

   **Monitor**
   Select this to monitor all projectors that have been registered in the group. If this is not selected, the settings made when the individual projectors were registered will be used.
   It cannot be set when creating a new group.

   ![Table]

   | **Group name** | Enter the name of the group to be displayed in Grouping view or Detail list view. Up to a maximum of 32 bytes can be entered. A space cannot be used as the first character. |
   | **Display icon** | Select the icon(s) to be displayed in Grouping view or Detail list view. |
   | **Parent group** | This selects the parent group. If no groups have been created, this cannot be selected. |

2. **When the setup is complete, click "Register" to start the registration. When the message is displayed, click "OK".**
   The icon(s) of the projector(s) you registered will be displayed in Grouping view or Detail list view.

3. **Right-click the projector icon(s) to register to the group you have created in Grouping view or Detail list view, and select "Edit".**
   You can also carry out this operation by selecting Edit in the Edit menu.

4. **In the Edit projector window, select the group name to use for registering in Parent group and then click "Change".**
   The status of the group registration will be displayed as an icon in Grouping view or Detail list view.
   The registration details can also be checked using Projector list in the View menu.
Registering and deleting projectors for monitoring

If the projector name or IP address changes after registration

For projectors that have been registered manually

**Procedure**

1. Right-click on a projector icon in Grouping view or Detail list view and select "Monitoring disabled". Then right-click the projector icon again and select "Edit".

   You can also carry out these operations by using the Edit menu.

2. If only the projector name has been changed, click "Search" in the Edit projector window that is displayed. If the IP address has been changed, enter the new IP address in the "IP address" box and then click "Search". When the message is displayed, click "OK".

3. When the display returns to the Edit projector window, click "Change".

For projectors that have been registered using automatic search

**Procedure**

1. Delete the projector(s) whose name or IP address has been changed in Grouping view or Detail list view. 📄 p.20

   You can also carry out this operation by selecting Delete in the Edit menu.

Carry out automatic search to re-register the projector(s).

p.12

Cancelling projector registrations (Delete)

The registrations for projectors can be deleted if they are no longer required for monitoring or control using EasyMP Monitor.

**Procedure**

Right-click the icon for the projector or group that is to be deleted in Grouping view or Detail list view and select "Delete". When the message is displayed, click "OK".

More than one projector can be selected for deleting by selecting in Grouping view or Detail list view.

The methods of selecting more than one projector at the same time are as follows:

- If you select a Group icon in Grouping view, all projectors that have been registered in that group will be deleted at the same time.
- Hold down the Ctrl key on the keyboard while clicking on the desired icons.
- Use drag and drop to select a range of desired icons.

You can also carry out this operation by selecting Delete in the Edit menu.
Types of monitoring windows and switching method

Types of monitoring windows

There are two types of monitoring windows. Select a desired window.

• Grouping view
  This view lets you check the status of group registrations in a hierarchical diagram.

• Detail list view
  This view lets you display the status of each projector as a list so that the projectors can be checked in detail. You can also display specific items as a list, and sort display items using a specific row as a sort key.

How to switch views

Grouping view and Detail list view are switched as follows.
**Procedure**

Click the View menu, and select "Grouping view" or "Detail list view".

---

**Monitoring using Grouping view**

**Meanings of Grouping view icons**

In Grouping view, the patterns on the icons indicate the statuses of the projectors. If the group icons are round in shape, it indicates that there is another level below them. 🗑️ p.23
The icon patterns and their meanings are explained below.

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No warnings or problems</td>
<td>All projectors in the group are normal.</td>
</tr>
<tr>
<td>Warning or problem</td>
<td>A projector in the group has a warning or problem status.</td>
</tr>
<tr>
<td>Notification</td>
<td>A projector requiring immediate attention has been detected within the group.</td>
</tr>
<tr>
<td>Monitoring disabled</td>
<td>The projector is not being monitored. If you right-click the icon and select Monitoring enabled, the projector will be added to the projectors that are being monitored.</td>
</tr>
<tr>
<td>Data being updated</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Projector</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No warnings or problems</td>
<td></td>
</tr>
<tr>
<td>Warning or problem</td>
<td></td>
</tr>
<tr>
<td>Notification</td>
<td></td>
</tr>
<tr>
<td>Monitoring disabled</td>
<td></td>
</tr>
<tr>
<td>Data being updated</td>
<td></td>
</tr>
<tr>
<td>Network error (Monitor Password authentication error)</td>
<td>No Monitor Password was entered when the projector was registered, or an incorrect Monitor Password was entered.</td>
</tr>
<tr>
<td>Network error (TCP connection error)</td>
<td></td>
</tr>
</tbody>
</table>

*1 When Temperature level display group view is set to On at Environment setup in the Tool menu, an icon indicating the internal temperature of the projector will be displayed on top of the projector icon. The default setting is Off. As you can get an idea of how the temperature inside the projector is increasing when Temperature level is displayed, you can make improvements to the projector's operating environment before a high internal temperature error or high-temperature warning occur. p.28

*2 Check the following items.
- Check that the projector's power is turned on.
- Check that the LAN cable is connected.
- Check that Standby Mode is set to Communication On (or Network On) or Network Monitoring is set to On in the projector's configuration menu.

*3 Check that the projector has been correctly connected to the network.

The projector information that is generated when a problem is detected is stored until EasyMP Monitor is closed. EasyMP Monitor displays will not be updated automatically even if the projector status returns to normal. Click "Refresh" in the main window to update the status.

Using the icons in Grouping view

The following icon operations can be carried out in Grouping view.

- **Expanding and collapsing icons**
  Each time you double-click a group icon, the icons for the projector that have been registered in that group are displayed or hidden.

- **Moving icons**
  To change the position of an icon within Grouping view, simply drag and drop the icon to be moved.
Monitoring using Detail list view

Meanings of Detail list view icons

The status of registered projectors is displayed as a list in Detail list view regardless of which Group the projectors belong to.
The icon patterns and their meanings are explained below.

1 **Type**
   Displays the projector status.
   - ![No warnings or problems](image)
     No warnings or problems\(^1\)
   - ![Warning or problem](image)
     An error has occurred on the projector.
   - ![Notification](image)
     The projector requires immediate attention.
   - ![Monitoring disabled](image)
     The projector is not being monitored. If you right-click the icon and select Monitoring enabled, the projector will be added to the projectors that are being monitored.
   - ![Data being updated](image)
   - ![Network error (Monitor Password authentication error)](image)
     No Monitor Password was entered when the projector was registered, or an incorrect Monitor Password was entered.  
     p.13, p.16, p.17
   - ![Network error (TCP connection error)](image)\(^2\)
   - ![Network error (ESC/VP.net communication error)](image)\(^3\)

2 **Group name**
   When projectors are registered to a group, the name of the group that the projector belongs to is displayed.

3 **Display name**
   Shows the display name.

4 **Power**
   Shows the power on status for the projector.
   - ![Power on and normal status](image)
   - ![Power on and abnormal status](image)
   - ![Power off and normal status](image)
   - ![Power off and abnormal status](image)

5 **Lamp Hours**
   Shows the lamp operating time for the projector. If the projector has 2 lamps, it shows the lamp operating time for both lamp 1 and lamp 2.

6 **Temperature level**
   The following five icons display the differing internal temperature status of the projector.
   - ![Internal temperature normal](image)
   - ![High-temperature warning](image)
   - ![Internal temperature error](image)

7 **Error information**
   Shows a notification or warning/problem status using the following icons.
   - ![Clean Air Filter Notice](image)
   - ![Replace Lamp (Lamp 1)](image)
   - ![Lamp error (Lamp 1)](image)
   - ![Lamp failure at power on (Lamp 1)](image)
   - ![High-temperature warning](image)
   - ![Replace Air Filter](image)
   - ![No Air Filter](image)
   - ![Low Air Flow](image)
   - ![Supply System Error (Ballast 1)](image)
   - ![Supply System Error (Ballast 2)](image)
   - ![Cinema filter warning](image)
   - ![Shutter warning](image)
   - ![Lamp Error](image)
   - ![Lamp Error (Lamp 1)](image)
   - ![Lamp Error (Lamp 2)](image)
   - ![Lamp failure at power on (Lamp 2)](image)
*1 When Temperature level display group view is set to On at Environment setup in the Tool menu, an icon indicating the internal temperature of the projector will be displayed on top of the projector icon. The default setting is Off.

*2 Check the following items.
- Check that the projector’s power is turned on.
- Check that the LAN cable is connected.
- Check that Standby Mode is set to Communication On (or Network On) or Network Monitoring is set to On in the projector’s configuration menu.

*3 Check that the projector has been correctly connected to the network.

*4 You can display Replace Lamp at any time preset at Environment setup in the Tool menu.

Detectable error information differs depending on the projector you are using.

Selecting display items

You can select only the required items to be displayed in Detail list view.

Procedure

1. Select "Option" from the View menu.
   The Option window will be displayed.

2. Select the check box of the item you want to display.

3. Click "OK".

- The projector information that is generated when a problem is detected is stored until EasyMP Monitor is closed. EasyMP Monitor displays will not be updated automatically even if the projector status returns to normal. Click "Refresh" in the main window to update the status.
When all of the details of the item cannot be displayed in Detail list view, drag the boundary line on the right of the item name so that the view is extended to the desired width.

Sorting lists

You can sort detailed lists by using a specific row as a sort key, such as projector name order or IP address order.

Procedure

Click the item name of the row you want to use as the sort key.

Searching for desired icons (Projector list)

The Projector list feature is useful for searching in lists when many groups and projectors are registered and the icon you are looking for is not displayed on screen.

Procedure

Select "Projector list" from the View menu.

The following window will be displayed.

With Projector list, temperature level icons are not displayed regardless of the setting of Temperature level display group view at Environment setup.

The Projector list lets you check the registration details for groups in a hierarchical diagram. When you click on an icon, Grouping view and Detail list view are scrolled so that the selected icon is displayed in the window.

Monitoring using the system tray

The projector statuses are always displayed as icons in the system tray, even when Grouping view or Detail list view is not always displayed, and the statuses can be checked by the icon patterns.
When the configuration menus are set using the following operations, an icon appears in the system tray and the status can be monitored by means of the icon’s pattern.

![Icon Example](image)

The icon patterns are explained below.

- No problem
- Problem

**Procedure**

1. **Select "Environment setup" from the Tool menu.**
   The Environment setup window will be displayed.

2. **Select "Resident in the task tray".**

![Environment Setup Window](image)

3. **Click "OK".**
   - Right-click the icon in the system tray to open a pop-up menu to select the Open the main screen or Exit.
   - If Register at startup in the Environment setup is selected, EasyMP Monitor starts automatically when the computer’s power is turned on. When using EasyMP Monitor under Windows Vista or Windows 7, you must have administrator authority in order to use this function.

**Displaying projectors with problem or warning statuses in a list**

You can display a list of only the projectors which have a problem or warning status.

**Procedure**

Select "Warning and Error Projector list" from the View menu.
The following Warning and Error Projector list window will be displayed.

![Warning and Error Projector List](image)
If you move the mouse pointer over the icon of the Error information, details of the error and the remedy will be displayed. If you double-click in a line, the properties for that projector will be displayed. 📚 p.32
The icon patterns and their meanings are explained below.

1 **Type**
   Shows the group or projector status.
   - No warnings or problems*1
   - Warning or problem
     An error has occurred on the projector.
   - Notification
     The projector requires immediate attention.
   - Monitoring disabled
     The projector is not being monitored. If you right-click the icon and select Monitoring enabled, the projector will be added to the projectors that are being monitored.
   - Data being updated

2 **Display name**
   Shows the display name.

3 **Power**
   Shows the power on status for the projector.
   - Power on and normal status
   - Power on and abnormal status
   - Power off and normal status
   - Power off and abnormal status

4 **Lamp Hours**
   Shows the lamp operating time for the projector.

5 **Source**
   Shows the input source that has been selected for the projector.

6 **Temperature level**
   The following five icons display the differing internal temperature status of the projector.

7 **Error information**
   Shows a warning/problem status using the following icons.
When Temperature level display group view is set to On at Environment setup in the Tool menu, an icon indicating the internal temperature of the projector will be displayed on top of the projector icon. The default setting is Off.

Check the following items:
- Check that the projector’s power is turned on.
- Check that the LAN cable is connected.
- Check that Standby Mode is set to Communication On (or Network On) or Network Monitoring is set to On in the projector’s configuration menu.

Check that the projector has been correctly connected to the network.

It describes DVI-D if the projector is equipped with both DVI-D and HDMI input terminal.

It describes HDMI if the projector is equipped with both DVI-D and HDMI input terminal.

You can display Replace Lamp at any time preset at Environment setup in the Tool menu.

Detectable error information differs with the projector you are using.

### Checking properties in detail

You can check the properties of Group and projectors in detail.

### Displaying Group properties

**Procedure**

You can use either of the following methods to display the properties.

- **Displaying the properties for all groups in Grouping view**
  Right-click in Grouping view and select **Property**.

<table>
<thead>
<tr>
<th>Error Category</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lamp error (Lamp 2)</td>
<td>Lamp failure at power on (Lamp 1)</td>
</tr>
<tr>
<td>Lamp failure at power on (Lamp 2)</td>
<td>High-temperature warning</td>
</tr>
<tr>
<td>Replace Air Filter</td>
<td>No Air Filter</td>
</tr>
<tr>
<td>Supply System Error (Ballast 1)</td>
<td>Supply System Error (Ballast 2)</td>
</tr>
<tr>
<td>Cinema filter warning</td>
<td>Shutter warning</td>
</tr>
<tr>
<td>Lamp Cover Open</td>
<td>Lamp Error</td>
</tr>
<tr>
<td>Lamp Error (Lamp 1)</td>
<td>Lamp Error (Lamp 2)</td>
</tr>
<tr>
<td>Lamp failure at power on (Lamp 1)</td>
<td>Lamp failure at power on (Lamp 2)</td>
</tr>
<tr>
<td>Lamp failure at power on (Lamp 2)</td>
<td>High internal temperature error</td>
</tr>
<tr>
<td>Low air flow error</td>
<td>Air filter air flow sensor error</td>
</tr>
<tr>
<td>Internal Error</td>
<td>Fan error</td>
</tr>
<tr>
<td>Sensor error</td>
<td>Supply System Error (Ballast)</td>
</tr>
<tr>
<td>Supply System Error (Ballast 1)</td>
<td>Supply System Error (Ballast 2)</td>
</tr>
<tr>
<td>Auto Iris Error</td>
<td>Cinema filter error</td>
</tr>
<tr>
<td>Shutter error</td>
<td>Cooling system error (Peltier element)</td>
</tr>
<tr>
<td>Cooling system error (pump)</td>
<td>Other error</td>
</tr>
</tbody>
</table>
• Displaying the specified group properties
Right-click an icon in Grouping view and then select **Property**.

If you double-click in a line, the properties for that group or projector will be displayed.

### Displaying Projector properties

Right-click on a projector icon in Grouping view or Detail list view and select **Property**.

<table>
<thead>
<tr>
<th>Information</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group name</td>
<td>Branch A</td>
</tr>
<tr>
<td>Projector name</td>
<td>test1</td>
</tr>
<tr>
<td>Display name</td>
<td>Lobby</td>
</tr>
<tr>
<td>IP address</td>
<td>192.168.0.234</td>
</tr>
<tr>
<td>Lamp Hours</td>
<td>334</td>
</tr>
<tr>
<td>Temperature level</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Serial Number</td>
<td></td>
</tr>
<tr>
<td>Version information</td>
<td>F1 140012000599999</td>
</tr>
<tr>
<td>F2 140012000599999</td>
<td></td>
</tr>
<tr>
<td>F3 140012000599999</td>
<td></td>
</tr>
<tr>
<td>Error information</td>
<td>No signal</td>
</tr>
</tbody>
</table>

1. Shows the projector's serial number. If hyphens are displayed, confirm the serial number on the label of the projector.
2. Displays the projector firmware version.

### Displaying and deleting logs

In your web browser, you can check a transmission log of content, such as what has been controlled by EasyMP Monitor, and projector errors. You can delete logs once you have checked them.
When Log output is set to On at Environment setup in the Tool menu, transmission logs are stored. The default setting is Off.

**Displaying Log**

**Procedure**

Select "Log" - "View" from the View menu.
The web browser will open and the communication logs up until that time will be displayed.

**Deleting Log**

**Procedure**

Select "Log" - "Delete" from the View menu. When the confirmation message is displayed, click "OK".
All logs will be deleted and details of EasyMP Monitor control operations and details of projector errors from that point onward will be recorded in a new log.
Using the control functions

Carrying out control using control buttons

Click the icon of a projector to be controlled in Grouping view or Detail list view, and click a control button to enable control of only that selected projector.

You can also enable control of all selected projectors by selecting more than one projector in Grouping view or Detail list view and clicking a control button. The methods of selecting more than one projector at the same time are as follow.

- If you select a group icon in Grouping view, all projectors that have been registered in that group and that are set to be monitored can be controlled at the same time.
- Hold down the **Ctrl** key on the keyboard while clicking on the desired icons.
- Use drag and drop to select a range of desired icons.
Using the control functions

The following table lists the control button functions.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Power On]</td>
<td>Turns the projector power on.</td>
</tr>
<tr>
<td>![Power Off]</td>
<td>Turns the projector power off.</td>
</tr>
<tr>
<td>![Switch source Computer1]</td>
<td>Switches the video input source to the Computer1 port or Computer port.</td>
</tr>
<tr>
<td>![Switch source Computer 2]</td>
<td>Switches the video input source to the Computer2 port.</td>
</tr>
<tr>
<td>![Switch source BNC]</td>
<td>Switches the video input source to the BNC port.</td>
</tr>
<tr>
<td>![Switch source S-Video]</td>
<td>Switches the video input source to the S-Video port.</td>
</tr>
<tr>
<td>![Switch source Video (RCA)]</td>
<td>Switches the video input source to the Video port or video2 port.</td>
</tr>
<tr>
<td>![Switch source Video (BNC)]</td>
<td>Switches the video input source to the Video1 port.</td>
</tr>
<tr>
<td>![Switch source DVI-D, HDMI 1]</td>
<td>Switches the video input source to the DVI-D1 port or HDMI1 port.</td>
</tr>
<tr>
<td>![Switch source DVI-D, HDMI 2]</td>
<td>Switches the video input source to the DVI-D2 port or HDMI2 port.</td>
</tr>
<tr>
<td>![Switch source D-Video]</td>
<td>Switches the video input source to the D4 port.</td>
</tr>
<tr>
<td>![Switch source EasyMP]</td>
<td>Switches the input source to EasyMP or EasyMP.net.</td>
</tr>
<tr>
<td>![Switch source USB Display*]</td>
<td>Switches the input source to USB Display.</td>
</tr>
<tr>
<td>![Switch source USB1*]</td>
<td>Switches the video input source to the external equipment connected via a USB (Type A) port or USB1.</td>
</tr>
<tr>
<td>![Switch source USB2*]</td>
<td>Switches the video input source to the external equipment connected via a USB2 port.</td>
</tr>
<tr>
<td>![Switch source LAN*]</td>
<td>Switches the video input source to the image projected by the computer via a network.</td>
</tr>
</tbody>
</table>

* If the button does not function, you can switch the input source using the button.

- Some connected projectors may not be equipped with all of the above ports or functions. If you click a button for a port or function that is not available, nothing will happen.
- You can select objects to be controlled and use the control buttons to carry out control operations even when the following are being displayed.
  Group properties p.31
  Projector properties p.32
  Warning and Error Projector list (Control operations can only be carried out for projectors with a warning status.) p.28
Carrying out control using a web browser (Web control)

You can use the computer’s web browser to change the configuration menu settings for projectors.

**Procedure**

1. Right-click on the icon of a projector to be controlled in Grouping view or Detail list view and select "Web control".

2. The web browser will open and the Web control window will be displayed.

Web control lets you set the same details as the configuration menu for the projector. Projector’s User’s Guide

You can select projectors and right-click on them to select Web control even when the following are being displayed.

- Group properties p.31
- Warning and Error Projector list (Control operations can only be carried out for projectors with a warning status.) p.28

Carrying out control using timer settings

This is useful for carrying out certain control operations such as turning a projector’s power on and off at specified times every day or every week. Timer settings can be carried out either for a single projector only, or all at once for all projectors in a group.

**Procedure**

Select "Timer" - "Timer Settings" from the Tool menu.

The following window will be displayed and you can then check the timer setting status.

1. **Projectors**
   Selects a group or projector to check the status of.
   When a group is selected, the timer setting statuses for all projectors in that group are displayed.
Using the control functions

2 Date
Shows the current day in a red box.
Days for which timer settings have been made are shown in bold.
Click [ ] or [ ] to switch to the calendar for the previous or next month.

3 Timers
Shows a list of the timer settings.
The line colors in the Timers list have the following meanings:
- Current day's timer setting
- When some of the projectors in the group have timer setting enabled and others have it disabled for the current day's timer setting
- When the current day's timer setting is a disabled setting
- Timer setting for a day other than the current day

4 Delete
Lets you delete timer settings that have been selected from the timer list.

5 Close
Closes the Timer Settings window.

6 Edit
Lets you change the timer settings that have been selected from the timer list. If a group has been selected for status checking, the settings cannot be changed.

7 Add
Registers new timer settings. "Procedures for new timer settings" p.37

8 Enabled/disabled
Switches the timer settings that have been selected from the timer list between enabled and disabled.

Procedures for new timer settings

Procedure

1 Click "Add" on the Timer Settings window. The following window is displayed and the new timer settings are applied.

For Operation, you can select operations such as turning the power on and off and switching the input sources, similar to the control buttons on the main window. If you set up input source switching, the projector's power will turn on at the timer start time even if it is not on at the time. Because of this, it is not necessary to make two separate timer settings for turning the power on and switching the input source.

2 After completing the timer settings, click "OK".
The timer settings that have been made will be registered and they can be checked in the displayed timer list.

You can enable and disable all of the timer settings that have been registered. Select Timer - Enable or Disable from the Tool menu.
Mail notification function settings

The mail notification function can be used to send corresponding notification messages to a preset e-mail address when a projector that is connected to the network assumes a certain status, or if it experiences a problem or warning. By using this function, the operator can be notified of a projector's status or problems even when the operator is in a different location from the projectors.

- Up to three addressees (destinations) can be registered and messages can be sent to all of them at once.
- If a critical problem develops with a projector which causes it to suddenly stop working, it may not be possible for the projector to send a message notifying an operator of the problem.
- If Standby Mode is set to Communication On (or Network On) or Network Monitoring is set to On in the projector configuration menus, you can monitor the projector even when it is in standby mode (when its power is turned off). Projector's User's Guide
- On some projectors, the mail notification function can be set in the configuration menu. When notification messages are set to be sent in the projector's configuration menu, both the settings in the configuration menu and settings made on EasyMP Monitor are functional.
- Detectable status with the mail notification function differs depending on the projector you are using.

Procedure

1 Select "Mail notification function" from the Tool menu.

The Set mail notification function window will be displayed.

| Mail notification function | Set to On to use the mail notification function. |
| SMTP server IP address     | Enter the IP address of the SMTP server. Up to a maximum of 255 bytes can be entered. When you change a port number of the SMTP server, specify this port number. The default value is "25". You can enter a valid number from 1 to 65535. |
| Sender mail address        | Enter the sender's e-mail address. Up to a maximum of 255 bytes can be entered. |
| Recipient mail address 1   | Specify the destination addresses for the notification e-mail. Up to three destinations can be set. Up to a maximum of 255 bytes can be entered. |
| Recipient mail address 2   | |
| Recipient mail address 3   | |
Mail notification function settings

3. Click "Notification event" and check the items for mail notification in the window that appears.

4. Click "OK".
   The Set mail notification function window appears again.
   Repeat Steps 3 and 4 to set the notification events to be notified.

5. When the setup is complete, click "OK".
E-mail notification

If the projector experiences a problem or enters a status requiring attention, an e-mail like that shown below is sent to the address specified for Recipient mail address.

If there is more than one problem, warning, or status, the corresponding messages are output to separate lines.

<table>
<thead>
<tr>
<th>Item</th>
<th>Details shown</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-mail subject</td>
<td>[Display name displayed in Grouping view or Detail list view] Projector status notification</td>
</tr>
<tr>
<td>Body</td>
<td>&lt;Display name displayed in Grouping view or Detail list view&gt; has entered the following status. &lt;Warning/error/status message (Please see the next table)&gt;</td>
</tr>
</tbody>
</table>
The details contained in the e-mail message can consist of the following.

<table>
<thead>
<tr>
<th>Message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Error</td>
<td>See your projector <em>User’s Guide</em></td>
</tr>
<tr>
<td>Fan error</td>
<td></td>
</tr>
<tr>
<td>Sensor error</td>
<td></td>
</tr>
<tr>
<td>Lamp Cover Open</td>
<td></td>
</tr>
<tr>
<td>Lamp failure at power on*</td>
<td></td>
</tr>
<tr>
<td>Lamp Error*</td>
<td></td>
</tr>
<tr>
<td>Supply System Error (Ballast)*</td>
<td></td>
</tr>
<tr>
<td>High internal temperature error</td>
<td></td>
</tr>
<tr>
<td>Low air flow error</td>
<td></td>
</tr>
<tr>
<td>Air filter air flow sensor error</td>
<td></td>
</tr>
<tr>
<td>Cinema filter error</td>
<td></td>
</tr>
<tr>
<td>Shutter error</td>
<td></td>
</tr>
<tr>
<td>Cooling system error (Peltier element)</td>
<td></td>
</tr>
<tr>
<td>Cooling system error (pump)</td>
<td></td>
</tr>
<tr>
<td>High-temperature warning</td>
<td></td>
</tr>
<tr>
<td>Replace Lamp*</td>
<td></td>
</tr>
<tr>
<td>Lamp error</td>
<td></td>
</tr>
<tr>
<td>Lamp failure at power on*</td>
<td></td>
</tr>
<tr>
<td>Supply System Error (Ballast)*</td>
<td></td>
</tr>
<tr>
<td>Replace Air Filter</td>
<td></td>
</tr>
<tr>
<td>No Air Filter</td>
<td></td>
</tr>
<tr>
<td>Low Air Flow</td>
<td></td>
</tr>
<tr>
<td>Air Flow Sensor Err.</td>
<td></td>
</tr>
</tbody>
</table>

* When the projector has 2 lamps, the additional information, such as (Lamp 1) or (Ballast 1), is displayed after the message so that you can know which lamp has problems/warnings.
Messages informing you that the projector has recovered from errors or warning statuses are sent.
Application lock function

You can use the application lock to prevent third parties from operating the projectors using EasyMP Monitor and from changing settings without authority. Opening and closing EasyMP Monitor and status monitoring can still be carried out even when the application lock is applied.

In addition, when a password has been set, the password must be entered in order to cancel the application lock. This ensures that the application lock can not be easily cancelled, and thus improves system security.

Switching Application lock between enabled and disabled

Enabling the application lock

Procedure

Select "Application lock" from the Tool menu.

The application lock will be enabled and no operations will be possible other than opening and closing EasyMP Monitor and disabling the application lock.

Disabling the application lock

Procedure

1. Select "Application unlock" from the Tool menu.

The password entry window will be displayed, so enter the set password and then click "OK".

If no password has been set (default setting), click OK without entering a password. It is recommended that you enter a password in order to strengthen security.

The application lock will be cancelled and operations can be carried out as normal.

Setting a password for cancelling application lock

Carry out the following operations while application lock is cancelled.

Procedure

1. Select "Environment setup" from the Tool menu.

The Environment setup window will be displayed.

2. Select "Change the application lock password".

The password can be up to 16 bytes in length. Single-byte alphanumeric characters can be used.
Appendix
# Troubleshooting

## Projectors cannot be monitored or controlled

<table>
<thead>
<tr>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the projector connected to the network correctly?</td>
<td>Check that the network cable has been connected correctly. If the cable is not connected correctly, reconnect it.</td>
</tr>
<tr>
<td>Has the projector been set up correctly for connection to the network?</td>
<td>Check the settings for the Network configuration menu command. <a href="#">Projector's User's Guide</a></td>
</tr>
<tr>
<td>Has EasyMP Monitor been installed on the computer correctly?</td>
<td>Uninstall EasyMP Monitor and then re-install it. <a href="#">p.8</a></td>
</tr>
<tr>
<td>Are all the projectors that you want to control or monitor registered?</td>
<td>Register the projectors. <a href="#">p.11</a></td>
</tr>
<tr>
<td>Is the projector's Standby Mode set to Communication On (or Network On) or Network Monitoring set to On in the configuration menu?</td>
<td>In order to use EasyMP Monitor to monitor and control the projector when it is in standby mode, the projector's Standby Mode must be set to Communication On (or Network On) or Network Monitoring must be set to On in the configuration menu. <a href="#">Projector's User's Guide</a></td>
</tr>
<tr>
<td>Has a critical problem developed causing the projector to momentarily stop working?</td>
<td>When the projector has momentarily stopped working, it cannot send e-mail messages. If the projector cannot be reset even after it has been checked, contact Epson.</td>
</tr>
<tr>
<td>Is power being supplied to the projector?</td>
<td>Check if the power supply to the location where the projector is set up has been interrupted, or if the circuit breaker for the electrical outlet that the projector is connected to has been tripped.</td>
</tr>
</tbody>
</table>

## An e-mail message is not sent when a problem occurs with a projector

<table>
<thead>
<tr>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the projector connected to the network correctly?</td>
<td>Check that the network cable has been connected correctly. If the cable is not connected correctly, reconnect it.</td>
</tr>
<tr>
<td>Has the projector been set up correctly for connection to the network?</td>
<td>Check the settings for the Network configuration menu command. <a href="#">Projector's User's Guide</a></td>
</tr>
<tr>
<td>Have the SMTP server IP address, Port Number and Recipient mail address all been set correctly?</td>
<td>Check the setting details.</td>
</tr>
<tr>
<td>Is the projector's Standby Mode set to Communication On (or Network On) or Network Monitoring set to On in the configuration menu?</td>
<td>In order to use EasyMP Monitor to monitor and control the projector when it is in standby mode, the projector's Standby Mode must be set to Communication On (or Network On) or Network Monitoring must be set to On in the configuration menu. <a href="#">Projector's User's Guide</a></td>
</tr>
<tr>
<td>Has a critical problem developed causing the projector to momentarily stop working?</td>
<td>When the projector has momentarily stopped working, it cannot send e-mail messages. If the projector cannot be reset even after it has been checked, contact Epson.</td>
</tr>
</tbody>
</table>
Uninstalling EasyMP Monitor

The following procedures to uninstall EasyMP Monitor vary depending on your operating system.

• If your operating system is Windows 98, Windows Me, Windows 2000, Windows NT4.0, or Windows XP
  Click Start - (Settings) - Control Panel - Add/Remove Programs or Add or Remove Programs to uninstall EasyMP Monitor. To save or transfer the existing projector settings, make a copy of the EMP Monitor.dat file before you uninstall the software. “Transferring the settings” p.7

• When your operating system is Windows Vista or Windows 7
  Click Start - Control Panel - Uninstall a program to uninstall EasyMP Monitor. The settings and logs remain on the hard disk after EasyMP Monitor is uninstalled. If you do not need this information, delete the EasyMP Monitor Ver. x.xx (Ver. x.xx represents the version of the existing software) folder. This folder can be found at “C:\Users\(User Name)\AppData\Local\VirtualStore\Program Files\EPSON Projector” if the default settings were used to install the software. To save or transfer the projector settings, make a copy of the EMP Monitor.dat file before you delete the folder. “Transferring the settings” p.7
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. No patent liability is assumed with respect to the use of the information contained herein. Neither is any liability assumed for damages resulting from the use of the information contained herein.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable against any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

Trademarks

Microsoft, Windows, Windows NT, Windows Vista, Windows 7, and Windows logo are trademarks of Microsoft Corporation in the United States of America and other countries.

Macintosh is a registered trademark of Apple Computer, Inc.

Pentium is a registered trademark of Intel Corporation.

Epson, EasyMP, and EasyMP.net are registered trademarks and Epson Exceed Your Vision is a registered logomark of Seiko Epson Corporation.

Other product names used herein are also for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

© Epson America, Inc. 2009

CPD-27792